LENESANS Release Note

RZ/T2H Group

Encoder I/F SSI sample program

Summary
This document describes the RZ/T2H Encoder I/F SSI sample program package.

For Synchronized Serial Interface (SSI) communication protocol specifications and encoder specifications,
contact manufacturer of each encoder to obtain it.

Functionality Checked Device
RZ/T2H Evaluation Board (RTKORZT2HXXXXXXXXX)
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RZ/T2H Group Encoder I/F SSI sample program

1. Package Contents

This package contains the following contents.
The RZ/T2H encoder interface supports up to 16 axes, but the sample program uses only 1 axis of them. If

you use with 2 axes or more simultaneously, modify the sample program to support required axes.

1.1 Software
e Source code

No. name Version
1 RZ/T2H SSI sample program (CR52 ver. *) 20
2 RZ/T2H SSI sample program (CA55 ver. *) 2.0

Note: This sample program has a CR52 version that runs on the CPU core Cortex-R52 and a CA55 version
that runs on the CPU core Cortex-A55. CR52 ver. and CA55 ver. are descriptions of the respective
version.

1.2 Document

No. Document name Version File name
1 RZ/T2H Group Encoder I/F SSI 2.01 (j) r11an0806j0201-rzt2h.pdf
sample program Release Note (e) r11an0806€j0201-rzt2h.pdf (this document)
2 RZ/T2H Group SSI sample 2.00 (j) r11an0805jj0200-rzt2h-ssi.pdf
program Application Note (e) r11an0805€j0200-rzt2h-ssi.pdf
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RZ/T2H Group

Encoder I/F SSI sample program

2. File Structure

The file structure and contents of this package are detailed below.

Top

— r11an0806jj0201-rzt2h.pdf
F— r11an0806ej0201-rzt2h.pdf
L— workspace

— Software

F— iccarm

— RZ_T2H_CR52_ssi.zip : RZ/T2H SSI sample program set

CR52 ver. (IAR)

L— RZ_T2H_CA55_ssi.zip

CA55 ver. (IAR)

L— RZ _T2H_CR52_0_primary

L— gce

|
|
|
| — RZ_T2H_CA55 0 _ssi : RZ/T2H SSI sample program set
|
|
|

: CPU_CTRL register setting program (IAR)

F— RZ_T2H_CR52_ssi.zip : RZ/T2H SSI sample program set

CR52 ver. (e? studio)

L— RZ_T2H_CA55_ssi.zip
— RZ_T2H_CA55 0_ssi : RZ/T2H SSI sample program set

CAS5S5 ver. (e? studio)

L— RZ_T2H_CR52_0 primary

L— Documents
— r11an0805jj0200-rzt2h-ssi.pdf
L— 1 1an0805ej0200-rzt2h-ssi.pdf

: CPU_CTRL register setting program (e? studio)

The file structure of the RZ_T2H_CRS52_ssi.zip and RZ_T2H_CA55 0_ssi folder is shown below.

Top folder

— configuration.xml
— ( Environment File Depending on Build Tool )

L— src

— hal_entry.c
— ssi_main.c
— siochar.c
F— siorw.c

— sio_char.h
L— drv

L— ssi
— iodefine_ssi.h
F— r_ssi_rzt2.c
F— r_ssi_rzt2_config.h
F— r_ssi_rzt2_dat.h
L— r_ssi_rzt2_if.h

: FSP configuration data

: SSI sample program
: SSI sample program
: SCI_UART sample program
: SCI_UART sample program
: SCI_UART sample program

: SSl register definition file
: SSlI driver file
: SSlI driver file
: SSl driver file
: SSl driver file

R11ANO806EJ0201 Rev.2.01
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RZ/T2H Group Encoder I/F SSI sample program

The file structure of the RZ_T2H_CR52_0_primary folder is shown below.

Top folder
— configuration.xml : FSP configuration data
— ( Environment File Depending on Build Tool )
L— src
L— hal_entry.c : CA55 start-up program
R11ANO806EJ0201 Rev.2.01 Page 4 of 18



RZ/T2H Group Encoder I/F SSI sample program

3. About SSI sample program

This section contains information necessary to use the complete set of SSI sample program.

3.1 Software Information

3.1.1 Base OS
This sample program is OS-independent.

3.1.2 Memory Size

Memory size used by this sample program and SSI driver is shown in the following table. This table does not
include memory size used by Flexible Software Package or C language libraries of the compiler.

(1) CR52 ver.

ltems Memory Size

EWARM e? studio

[kBytes] [kBytes]
SSI driver Code 3.7 3.0
Data (with initial value) 0.0 0.0
Data (without initial value) 2.8 2.8
Constant Data 0.2 0.2
Sample program Code 4.2 4.7
Data (with initial value) 0.0 0.0
Data (without initial value) 0.6 0.6
Constant Data 14 14

(2) CADS55 ver.
ltems Memory Size

EWARM e? studio

[kBytes] [kBytes]
SSI driver Code 5.0 4.3
Data (with initial value) 0.0 0.0
Data (without initial value) 29 3.1
Constant Data 0.3 04
Sample program Code 71 7.9
Data (with initial value) 0.0 0.0
Data (without initial value) 0.6 0.6
Constant Data 1.6 1.7
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RZ/T2H Group

Encoder I/F SSI sample program

3.2 Hardware Information
3.2.1 Device
RZ/T2H

3.2.2 Target Board
(1) Board Name

RZ/T2H Evaluation Board (RTK9RZT2H0C00000BJ)

(2) Setting of the Target Board
The target board configuration is as follows.
SW1-4: ON
SW1-6: OFF
SW2-1: ON, SW2-2: OFF
SW2-7: OFF
SW2-8: OFF

SW14-1: ON, SW14-2: OFF, SW14-3: ON, SW14-6: OFF (Set xSPI1 boot mode)

CN39: Short between 2-3 pins (Set VDD1833_2 to 3.3 V)
CN40: Short between 2-3 pins (Set VDD1833_3 to 3.3V)

CN78: Short between 1-2 pins, Open between 3-4 pins, and between 5-6 pins (Set VDD1833_6 to 3.3V)

Note: To use evaluation board RTKORZT2HOCW1000BJ with connecting RS-485 board, power on/off by
plugging and unplugging to the power-supply connector CN47 with keeping the slide switch SW16 on.

R11ANO806EJ0201 Rev.2.01
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Encoder I/F SSI sample program

(3) Used Pins of the Target Board

The correspondence between the pin used as the encoder I/F and the pin header of the target board is as

follows.
Channel Pin name Pin header | Input/Output Voltage Description
domain
SSI0 ENCIFDIOO (SLO) CN2 #9 Input VDD33 Data input
ENCIFCKO00 (MAO) CN2 #3 Output vVDD33 Clock output
SSI1 ENCIFDIO1 (SL1) CN2 #8 Input VDD1833_3 Data input
ENCIFCKO01 (MA1) CN2 #2 Output VDD1833_3 Clock output
SSI2 ENCIFDIO2 (SL2) CN2 #17 Input VDD33 Data input
ENCIFCKO02 (MA2) CN2 #11 Output vVDD33 Clock output
SSI3 ENCIFDIO3 (SL3) CN2 #18 Input VDD33 Data input
ENCIFCKO03 (MA3) CN2 #12 Output VDD33 Clock output
SSl4 ENCIFDIO4 (SL4) CN2 #27 Input VDD1833_5 Data input
ENCIFCKO04 (MA4) CN2 #21 Output vVDD33 Clock output
SSI5 ENCIFDIO5 (SL5) CN2 #26 Input VDD1833_6 Data input
ENCIFCKO05 (MA5) CN2 #20 Output VDD1833 6 Clock output
SSI6 ENCIFDIO6 (SL6) CN3 #9 Input VDD1833_3 Data input
ENCIFCKO06 (MAG) CN3 #3 Output VDD1833_3 Clock output
SSI7 ENCIFDIO7 (SL7) CN3 #8 Input VDD1833_3 Data input
ENCIFCKO7 (MA7) CN3 #2 Output VDD1833_3 Clock output
SSI8 ENCIFDIO8 (SL8) CN3 #17 Input VDD33 Data input
ENCIFCKO08 (MAS8) CN3 #11 Output vDD33 Clock output
SSI9 ENCIFDIO9 (SL9) CN3 #18 Input VDD1833_2 Data input
ENCIFCKO09 (MA9) CN3 #12 Output VDD1833_2 Clock output
SSIM0 ENCIFDI10 (SL10) CN3 #27 Input VDD1833_2 Data input
ENCIFCK10 (MA10) CN3 #21 Output VDD1833_2 Clock output
SSI11 ENCIFDI11 (SL11) CN3 #26 Input VDD1833_2 Data input
ENCIFCK11 (MA11) CN3 #20 Output VDD1833_2 Clock output
SSIM2 ENCIFDI12 (SL12) CN10 #9 Input VDD1833_6 Data input
ENCIFCK12 (MA12) CN10 #3 Output VDD1833_6 Clock output
SSI13 ENCIFDI13 (SL13) CN10 #8 Input VDD1833_6 Data input
ENCIFCK13 (MA13) CN10 #2 Output VDD1833_6 Clock output
SSi14 ENCIFDI14 (SL14) CN10 #17 Input VDD33 Data input
ENCIFCK14 (MA14) CN10 #11 Output vDD33 Clock output
SSI15 ENCIFDI15 (SL15) CN10 #18 Input VDD33 Data input
ENCIFCK15 (MA15) CN10 #12 Output VDD33 Clock output
R11ANO806EJ0201 Rev.2.01 Page 7 of 18
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RZ/T2H Group

Encoder I/F SSI sample program

3.3 Procedures on Development Environments: CR52 ver.

3.3.1 Preparation before Executing the Sample Program

This sample program communicates with a PC. The USB connection terminal on the target board is CN34.
Select higher-numbered port from COM ports that appear at connecting the board with the host PC.

The terminal software of the host PC is set as shown in the following table.

Function Setting
Communication method Asynchronous serial transmission/reception
Sending / receiving order LSB first
Transfer rate 19200 bps
Character length 8 bits
Stop bit length 1 bit
Parity function None
Hardware flow control None

3.3.2 EWARM: IAR Systems
(1) Build Environment

IAR Embedded Workbench for ARM (EWARM)

Version 9.60.2 + patch (EWARM_Patch_for RZT2H N2H_rev1.0)
RENESAS FSP Smart Configurator (FSP SC) 2024-10
RENESAS Flexible Software Package (FSP) for RZ/T2 v2.2.0

(2) Execution Environment ICE
IAR I-jet

(3) Build Procedure for Sample Programs
The build procedure for the sample program is as follows.

1 Extract RZ_T2H_CR52_ssi.zip and copy the extracted source files to the desired location.
2 Activate EWARM

3 Select [File] menu -> [Open Workspace].

4 Open the extracted source file RZ_T2H_ssi.eww

5 Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE. *

Note The following procedure adds the activation of the FSP Smart Configurator to the [Tools] menu of the
EWARM IDE. Select [Tools] menu -> [Tool Configuration] in the EWARM IDE. Select the [New]
button, specify a table string in each field, and press [OK].

Field String
Menu text FSP Smart Configurator
Command $RASC_EXE_PATHS$
Argument --compiler IAR configuration.xml
Initial directory $PROJ_DIR$

String for the command is variable holding the path of the Smart Configurator execution file, rasc.exe.

You can also start the FSP Smart Configurator directly from the command prompt by specifying the
folder where it is installed.

R11ANO806EJ0201 Rev.2.01 Page 8 of 18



RZ/T2H Group Encoder I/F SSI sample program

6 Inthe FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rzt,
rzt_cfg, rzt_gen, script and .setting folders will be generated.

!E C:¥1_Prog¥Work¥Work_C¥Work_EWA_960 2 fsp2.2.0¥RZT2H_SS| release_chk - FSP Smart Configurator — O ® |
File Window Run Help
FT2H_SS|_release_chk] FSP Configuration FSP V ion = [
Summary Generate Project Content r'
Project Summary . A
RENESAS
Board: RZT2H Evaluation Board (RAM execution without flash memory)
Device: ROADSGO7TTM44GBG
Core: CR52 CPUO
FSP Version: 220
Project Type: Fl¢ B 1G90909940534s8tt0sas0es L
Location: C:/1_Prog/Work/Work_C/Work_EWA_960_2_fsp2 2 0/RZT2H_SSI_release_chk <=
Selected software components
Board support package for RSADSGO7TTM44GBG v220
Board support package for RZT2H v220 E
Board support package for RZT2H - FSP Data v220 i
Summary b A
a = 0O B console - o )

No consoles to display at this time.

7 When project generation is complete, close the Smart Configurator.
8 Select [Rebuild ALL] from the [Project] menu of EWARM.
The file Debug\Exe\RZ_T2H_ssi.out is generated.

(4) Sample Program Execution Procedure

After executing the "build procedure", connect the target board and debugger correctly, and perform the
following operations.

1 Select [Project] menu -> [Download and Debug].
2 Select [Debug] menu -> [Execute].

(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see
4.11.8 console commands in the RZ/T2H Group SSI Sample Program Application Note.

. COM10 - Tera Term VT - u] X
774 WP IVRO-JHO) 24V EW) ALTH)
rt

R/EE E
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RZ/T2H Group Encoder I/F SSI sample program

3.3.3 e?studio: RENESAS
(1) Build Environment

RENESAS e? studio 2024-10
Toolchain version: GNU ARM Embedded 12.2.1.arm-12-24
RENESAS Flexible Software Package (FSP) for RZ/T2 v2.2.0

(2) Execution Environment ICE
SEGGER J-Link v7.98c

(3) Build Procedure of the Sample Program
The procedure for building the sample program is as follows.

1 Extract RZ_T2H_CR52_ssi.zip and copy the expanded source file to the desired location.

2 After launching e? studio and moving to the workspace, click the [File] menu -> [Import] and select
Existing projects into workspace and click [Next].

3 On the project import screen, select the folder where the sample program was expanded as the root
directory.

4 Select a project, check Copy Project to Workspace, and click [Finish].

5 Double-click the configuration.xml in the Project Explorer pane of e? studio to open it.

Q RZT2H_S5I_release_chk - e studic - O b
File Edit Source Refactor Navigate Search Project RenesasViews Run Renesas Al Window Help

-4~ 8 ifp v Q- Q E| e
{3 Project Explorer X = m = 0O || Outline X Ll b [

=k There is no active editor that | &a
v |5 RZ_T2H _ssi [Debut provides an outline.

il Includes

o
1o configurationxmi '
h Te o peoug. ratjlink

X] RZ_T2H_ssi Debug_Flatlaunch

7) Developer Assistance

2! Problems X | B Console| (=] Properties| @& Smart Browser | &) Smart Manual g 2 8
0 errors, 12 wamings, 0 others
Description Resource Path Location Type

5 Warnings (12 items)

o configurationxml - RZ_T2H_ssi

R11ANO806EJ0201 Rev.2.01 Page 10 of 18



RZ/T2H Group Encoder I/F SSI sample program

6 Click Generate Project Content in the FSP Configuration pane of e? studio.
The rzt, rzt_cfg, rzt_gen, script and .settings folders are generated.

@8 RZT2H_SSI_release_chk - RZ_T2H_ssi/configuration.xml - € studio = | ®
File Edit Source Refactor Navigate Search Project RenesasViews Run Renesas Al Window Help
D-&~ o ity Q- Q e+
(3 Project Explorer % | 1= % =0 [RZ_T2H_ssi] FSP Configuration X = 85 Outline =F
~ 15 RZ_T2H ssi Sikmmary o There is no active editor that provides an |
4 Includes Generate Project Content | outline.
sic
4 Project Summary A
configurationxml RENESAS
RZ_T2H_ssi Debug Flatjlink
¥) RZ_T2H_ssi Debug_Flatlaunch Board: RZT2H Evaluation Board (RAM execution without flash memory)
=T &= Device: ROADIGOTTMA4GBG
Developer Assistance
Core: CR52 CPUO
Toolchain: GCC for Renesas RZ
Toolchain Version: 122 1.am-12-24
FSP Version: 220
Project Type: Flat
Location: C./1_Prog/Work/Work_C/Work_E2S_RZ../RZT2H_SSI_release_chk/RZ_T2H_ssi <=
Selected software components
Board support package for ROA09G077TM44GBG v2.20
Board support package for RZT2H v220 v
Board support package for RZT2H - FSP Data v2.2.0
Summary | BSP Clocks| Pins | Interrupts Event Links Stacks | Components
v Problems X | & Console| [Z] Properties| @ Smart Browser L} Smart Manual =
0 errors, 12 wamings, 0 others
Description Resource Path Location Type
b Wamings (12 items)
configurationxml - RZ_T2H_ssi

7 Select [Project] menu -> [Build All]
The Debug\RZ_T2H_ ssi.elf file is generated.

(4) Execution Procedure of the Sample Program

After executing the "build procedure", connect the target board and debugger correctly, and perform the
following operations.

1 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging].
2 Click [Debug] to start downloading to internal RAM.

3 Click [Run] menu -> [Resume] to run the sample program.

(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see
4.11.8 console commands in the RZ/T2H Group SSI Sample Program Application Note.

" COM10 - Tera Term VT - [m] X
BES) IvFO-INO)  D42FIW) ALFH)
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3.4 Procedures on Development Environments: CA55 ver.

3.4.1 Preparation before Executing the Sample Program

This sample program communicates with a PC. The USB connection terminal on the target board is CN34.
Select lower-numbered port from COM ports that appear at connecting the board with the host PC.

The terminal software of the host PC is set as shown in the following table.

Function Setting
Communication method Asynchronous serial transmission/reception
Sending / receiving order LSB first
Transfer rate 19200 bps
Character length 8 bits
Stop bit length 1 bit
Parity function None
Hardware flow control None

3.4.2 EWARM: IAR Systems
(1) Build Environment

IAR Embedded Workbench for ARM (EWARM)

Version 9.60.2 + patch (EWARM_Patch_for RZT2H N2H rev1.0)
RENESAS FSP Smart Configurator (FSP SC) 2024-10
RENESAS Flexible Software Package (FSP) for RZ/T2 v2.2.0

(2) Execution Environment ICE
IAR I-jet

(3) Build Procedure for Sample Programs
The build procedure for the sample program is as follows.

1 Extract RZ_T2H_CA55_ssi.zip and copy the extracted source files to the desired location.
Activate EWARM.

Select [File] menu -> [Open Workspace].
Open the extracted source file RZ_T2H_CR52 primary -> RZ_T2H_CR52_0_primary.eww.
Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE. *

a b owODN

Note The following procedure adds the activation of the FSP Smart Configurator to the [Tools] menu of the
EWARM IDE. Select [Tools] menu -> [Tool Configuration] in the EWARM IDE. Select the [New]
button, specify a table string in each field, and press [OK].

Field String
Menu text FSP Smart Configurator
Command $RASC_EXE_PATHS$
Argument --compiler IAR configuration.xml
Initial directory $PROJ_DIR$

String for the command is variable holding the path of the Smart Configurator execution file, rasc.exe.

You can also start the FSP Smart Configurator directly from the command prompt by specifying the
folder where it is installed.

R11ANO806EJ0201 Rev.2.01
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6

rzt_cfg, rzt_gen, script and .setting folders will be generated.

[[G C¥1_Prog¥WorkéWark C¥Work_EWA_960 2 fsp2.2.04RZT2H_SSI CASS.release_chk¥RZ_T2H_CRS2.0_primary - FSP Smart Configurater

[m] x ‘
File Window Run Help
8} [RZ_T2H_CR52_0_primary] FSP Configuration = FSP =
o :
2 »
Summary Generate Project Content i 2 =
Project Summa A
: B RENESAS 3N
Board: RZT2H Evaluation Board (RAM execution without flash memory)
Device: ROA09GOTTM44GBG
Core: CR52 CPUD

FSP Version: 22.0
Project Type: Flat

Location: C/1_Prog/Work/Work_C/Work_EWA_96 _release_chk/RZ_T2H_CRS52_0_primary cjs|

Selected software components

Board support package for ROA09GO77M44GBG

V220
Board support package for RZT2H v220
Board support package for RZT2H - FSP Data v2.2.0 v

O8O0

Summary| BSP| C » A
[ Properties (8] Problems e § = O B console ~M~= 0
Property Value No consoles to display at this time.

When project generation is complete, close the Smart Configurator.
Select [Rebuild ALL] from the [Project] menu of EWARM.

The file Debug\Exe\RZ_T2H_CR52_0_primary.sbd is generated.

9 Select [File] menu -> [Open Workspace].

10 Open the extracted source file RZ_T2H_CA55_0_ssi-> RZ_T2H_CA55_0_ssi.eww.

In the FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rzt,

(RZ_T2H_CR52_0_primary.sbd of the primary project is referenced to open this workspace file.

Please build the primary project in advance.)

11 Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE.

12 In the FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rzt,

rzt_cfg, rzt_gen, script and .setting folders will be generated.

IG 1 Prog¥WorkiWork C¥Work EWA 960 2 fsp2.2.04RZT2H SSICASS release_chk¥RZ_T2H_CASS 0 ssi - FSP Smart Configurator

File Window Run Help

{8} [RZ_T2H_CAS5_0.ssi] FSP Configuration X

Core: CAS55 Core0
FSP Version: 220
Project Type: Flat
Location: C:/1_Prog/Work/Work_C/Work_EWA_96
Selected software components

Board support package for ROA0SGOT7MA4GBG
Board support package for RZT2H
Board support package for RZT2H - FSP Data

LEO

Summary

[ Properties (&1 Problems

s are not available.

%5 Fsp

Sumimary Generate Project Content
Project Summai )
; L RENESAS
Board: RZT2H Evaluation Board (RAM execution without flash memory)
Device: RIADIGO7TM44GBG

AS55_release_chk/RZ_T2H_CAS55_0_ssi o~

v220
v2.2.0
V220 %

8§ =0 B console

No consoles to display at this time.

13 When project generation is complete, close the Smart Configurator.
14 Select [Rebuild ALL] from the [Project] menu of EWARM.
The file Debug\Exe\ RZ_T2H_ CA55 0_ssi.out is generated.
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RZ/T2H Group Encoder I/F SSI sample program

(4) Sample Program Execution Procedure

After executing the "build procedure", connect the target board and debugger correctly, and perform the
following operations.

1 Inthe workspace of RZ_T2H_CR52_0_primary, select [Project] menu -> [Download and Debug].
RZ_T2H_CA55_0_ssi project is launched.

2 Inthe workspace of RZ_T2H_CR52_0_primary, select [Debug] menu -> [Execute]. CA55 start-up
program is executed.

3 Inthe workspace of RZ_T2H CA55 0_ssi, select [Debug] menu -> [Execute]. Sample program is
executed.

(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see
4.11.8 console commands in the RZ/T2H Group SSI Sample Program Application Note.

M COMS9 - Tera Term VT - [m] x
IYRO-JHO) D4V EIW)  ALTH)

3.4.3 e€?studio: RENESAS
(1) Build Environment

RENESAS e? studio 2024-10
Toolchain version:
GNU ARM Embedded 12.2.1.arm-12-24 (Used by RZ_T2H_CR52_0_primary.)
GCC ARM A-Profile (AArch64 bare-metal) 10.3.1.20210621 (Used by RZ_T2H_CA55_0_ssi.)
RENESAS Flexible Software Package (FSP) for RZ/T2 v2.2.0

(2) Execution Environment ICE
SEGGER J-Link v7.98c

(3) Build Procedure of the Sample Program
The procedure for building the sample program is as follows.

1 Extract RZ_T2H_CA55_ssi.zip and copy the expanded source file to the desired location.
2 After launching e? studio and moving to the workspace, click the [File] menu -> [Import] and select
Existing projects into workspace and click [Next].
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RZ/T2H Group Encoder I/F SSI sample program

3 On the project import screen, select the folder where the sample program was expanded as the root
directory.

4 Select a project, check Copy Project to Workspace, and click [Finish].

5 Double-click the configuration.xml of the RZ_T2H_CR52_0_primary project in the Project Explorer
pane of e? studio to open it.

ﬁ RZT2H_S5I_CASS release_chk - &% studio — [m] * ‘
File Edit Source Refactor Navigate Search Project RenesasViews Run Renesas Al Window Help

B-] - o its v Q- Q E | Bl
I3 Project Explorer < =0 = 0O ||E= Outline X = R

— There is no active editor that ~ (&a)

~ |&5 RZ_T2H_CA55.0 ssi provides an outline

m Includes

@3 src

2 configurationxmil

RZ_T2H_CA55_0_ssi Debug_Flatjlink
RZ_T2H_CA55_0_ssi Debug_Flatlaunct
Developer Assistance

~ |5 RZ_T2H_CR52_0_primary [Debug

m* Includes
o

*. Problems x | B Console [Z] Properties| @ Smart Browser | &} Smart Manual i m

RZ_T2H_CR52_0_primary Debug_Flatj |0 errors, 24 warnings, 0 others
X| RZ_T2H_CR52 0_primary Debug Flatl| | Description Resource Path
7) Developer Assistance L Wamings (24 items)

F:

) =

Location Type

19 configurationxml - RZ_T2H_CR52_0_primary | | " ”

6 Click Generate Project Content in the FSP Configuration pane of e? studio.

The rzt, rzt_cfg, rzt_gen, script and .settings folders are generated in the RZ_T2H_CA55 0_ssi
project.

Q RZT2H_SSI_CASS_release_chk - RZ_T2H_CRS2_0_primary/cenfiguration.xml - e studio - a X ‘

File Edit Source Refactor Navigate Search Project RenesasViews Run RenesasAl Window Help

Br& witsr Qv Q | e
il SRS, Nl bt ! e
{3 Project Explorer X =] % § = DO || [RZ_T2H_CR52.0_primary] FSP Configuration > =_0 5= Outline X S oy
~ |5 RZ_T2H_CAS5 0 ssi Summary 0 There is no active editor that providesan | €9

i Includes Generate Project Content outline.

@ sc

F Project Summa ~

8 configurationxmi Jl ry =

RZ_T2H_CAS5_0_ssi Debug_Flatjlink
% RZ_T2H_CASS_0_ssi Debug_Flatlaunch Board: RZT2H Evaluation Board (RAM execution without flash memory)
%) D = R - Device: ROAQIGO7T7M44GBG
eveloper Assistance
v |5 RZ_T2H_CR52_0_primary [{ Cory: G2 CRD
Includes Toolchain: GCC for Renesas RZ

o

B e Toolchain Version: 12.2.1.arm-12-24

& ey FSP Version: 220

B Rz 'gu CR52.0, Debug_Flat! Plojeet Trpe: i

nary .
IS prmaly den P | Locstion: C:/1_Prog/Work/Work_C/Work_E25_RZ _ release_chk/RZ_T2H_CR52_0_primary &=

% RZ_T2H_CR52_0_primary Debug_Flatlar

2 Developer Assistance Selected software components

Board support package for ROADIGO7TM44GBG V220
Board support package for RZT2H v220
Board support package for RZT2H - FSP Data v220 e

o|o[Y

Summary| BSP| Clacks Pins| Interrupts Event Links | Stacks| Components
*! Problems x | B Console| [T] Properties @ Smart Browser L} Smart Manual g =0
0 erors, 24 wamings, 0 others

Description Resource Path Location Type
# Warnings (24 items)

< >

&} configurationxml - RZ_T2H_CRS2_0_primary

7 Select RZ_T2H_CR52_primary project in the Project Explorer pane and execute [Run] menu -> [Build
Project].
The file Debug\RZ_T2H_CR52_0_ primary.sbd is generated.

8 Double-click the configuration.xml of the RZ_T2H_CA55_0_ssi project in the Project Explorer pane of
e? studio to open it. (RZ_T2H_CR52_0_primary.sbd of the primary project is referenced to open this
configuration file. Please build the primary project in advance.)
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9 Click Generate Project Content in the FSP Configuration pane of e? studio. The rzt, rzt_cfg, rzt_gen,
script, .settings folders are generated in the RZ_T2H_CA55 0_ssi project.

10 Select [Project] menu -> [Build All]
Files Debug\RZ_T2H_CA55_0_ssi.elf is generated.

(4)

Execution Procedure of the Sample Program

) RZT2H_SS|_CASS_release_chk - RZ_T2H_CASS_0_ssi/configuration.eml - € studio
File Edit Source Refactor Navigate Search Project RenesasViews Run Renesas Al Window Help
LR witgr Qo
{3 Project Explorer X =) & § = DO ||# [Rz_T2H_CR52.0_primary] FSP Configuration i} [RZ_T2H_CAS5_0.ssi] FSP C X =
~ |25 RZ_T2H_CAS5_0_ssi Sk
i Includes y Generate Project Content
@ src
& i Project Summai )
{8 configurationxm| ) ry I
RZ_T2H_CAS5_0_ssi Debug_Flatjlink
% RZ_T2H_CASS_0_ssi Debug_Flatiaunch Board: RZT2H Evaluation Board (RAM execution without flash memory)
%) D B R " Device: ROADIGOTTMA4GBG
eveloper Assistance
v g5 RZ_T2H_CR52_0_primary Cory: Cae3 Camd
P Binaries Toolchain: GCC for Renesas RZ (A-Profile AATChG4 bare-metal)
= Toolchain Version: 10.3.1.20210621
& Includes
8 ot FSP Version: 220
= Project Type: Flat
. 1Egen Location: C:/1_ProgMork/Work_C/Work_E2S_RZ _A55_release_chk/RZ_T2H_CA55_0_ssi &=
@ src
@& Debug Selected software components
& ztcfg
& script Board support package for ROAOOGO77TM44GBG V220
{8} configurationxml Board support package for RZT2H v220
RZ_T2H_CR52_0_primary Debug_Flatjlil Board support package for RZT2H - FSP Data v220 i
%) RZ_T2H_CR52_0_primary Debug_Flatlai e
) Developer Assistance D X
Support il =
Summary | BSP| Clocks| Pins| Interrupts | Event Links| Stacks | Components
* Problems B Console % | [T] Properties @ Smart Browser L} Smart Manual ® 3,
CDT Build Console [RZ_T2H_CAS5_0_ssi]
< >

- O x ‘
Q @B
T—
2% Outline X = 0|g

There is no active editor that provides an | &a
outline.

«& 20~-5~-=0

After executing the "build procedure", connect the target board and debugger correctly, and perform the

following operations.

1 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging] for the

RZ_T2H_CR52_0_primary project.
Click [Debug] to start downloading to internal RAM.
2 Click [Run] menu -> [Resume] to run the CA55 start-up program.

3 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging] for the

RZ_T2H_CA55 0_ssi project.

4 Select 'No' when the dialog box inquiring about termination of the active debug session is displayed.

ﬁ Launcher

A Renesas GDB debug session is already active.

Do you want to terminate all currently active debug sessions before starting the new
session? (Note: Selecting No may result in unstable debug functionality)

[] Remember my decision

Cancel

5 If 'Proceed with launch' is displayed, select 'Yes'.
6 Click [Debug] to start downloading to internal RAM.
7 Click [Run] menu -> [Resume] to run the sample program.

X
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(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see
4.11.8 console commands in the RZ/T2H Group SSI Sample Program Application Note.

1 COMS - Tera Term VT - u] X
774 WP 3] E(S) IVRO-HO) 24V EW)  ALTH)
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the

level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an I/0 pull-up power supply while the device is powered off. The current injection that results from input of such a signal or /0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between V.
(Max.) and Vi1 (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between Vi (Max.) and Vix (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.



Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of
your product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the
use of these circuits, software, or information.

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.

3. Nolicense, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.

5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for

each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas
Electronics disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas
Electronics product that is inconsistent with any Renesas Electronics data sheet, user’'s manual or other Renesas Electronics document.

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for

Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by

Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc.

Renesas Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products

outside of such specified ranges.

Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific

characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability

product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you
are responsible for evaluating the safety of the final products or systems manufactured by you.

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.

12. ltis the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.
(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1  October 2020)

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan

www.renesas.com

Trademarks
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